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The Kodak i1400 Series Scanners provide the ability to process
scanned images to improve their quality by using image processing
features.

Image processing refers to features of the scanner that allow you to
automatically adjust each image that may improve the resulting images
(i.e., correcting any skew in the fed document, cutting the edges of the
image off to remove unneeded borders or cleaning up extraneous
“noise” on the image).

The information in this guide provides procedures for using the ISIS
Driver as well as descriptions of the features. The same features should
be available on the user interface of the scanning application you are
using (i.e., Kodak Capture Software).
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Starting the Scan 1. Select Start>Programs>Kodak>Document Imaging>Scan
Validation Tool Validation Tool.
x

Diriver Types:

Dirivers:

[

2. Select ISIS for the Driver Type and the Kodak Scanner i14XX
Scanner as the Driver. The Scan Validation Tool dialog box will be
displayed.

NOTE: For a description of the icons on the Scan Validation Tool
dialog box, see the section entitled, “Scan Validation Tool
dialog box” at the end of this guide.

JLTE

2 ) 30 0 0 5 o
Digplay Every: |1_

Total Last File: I

. o . . I

. Click the Setup icon . The Setup dialog box will be displayed.
setup x|
r— Compression ]

Front Calar:

JPEG
Front Bitonal:

Group-4

Fear Calar: [none)
JPEG

Fear Bitonal: [none)
Group-4

4. Click ISIS to display the Main tab.
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Using the ISIS driver  The Kodak i1400 Series Scanners can provide a wide variety of
electronic images. This can be done by using the ISIS Driver which is
created and maintained by EMC Captiva and is provided with the
scanner by Kodak. Many scanning applications support ISIS drivers
and this driver can be used to interface with them. The ISIS Driver is
the part of the capture system which links the scanner to your scanning
application.

This guide provides descriptions of the options on the tabs of the main
ISIS Driver window and how to set these options.

For the purpose of this manual, all displayed windows assume the
features available on the Kodak i1405, i1420 and i1440 Scanners. If
you have a Kodak i1410 Scanner, all options are limited to one-sided
scanning only.

See the section entitled, “Starting the Scan Validation Tool” earlier in
this document to access the ISIS Driver.
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The Scan Validation The Scan Validation Tool (SVT) is a diagnostic application provided by

Tool di a|og box Kodak. The SVT user interface allows access to all the features of the
scanner and is a good way to verify that the scanner is working
properly. The Scan Validation Tool allows you to verify scanner
functionality using the ISIS driver.

&€ Scan Yalidation Tool - TWAIN 10l =|

(2@ [ o] 5 [ =] [ |0 O [

V¥ Save Images To Files Dizplay Ewvery: |1

Toolbar buttons

Tatal: Last File: I

Setup — displays the user interface for the selected driver.

Destination — allows you to select a directory to store scanned
= images and their file names. This option is only available when
Save Images to Files is selected.

Start Scanning — scans the documents in the input tray.

Scan One Page — scans only one page.

|

Stop Scanning — ends the scan session.

License Key — displays the License Key window
No Image Display mode — closes the Image Viewer window
(no images will be displayed).

One Image Display mode — displays one image at a time.

Two Image Display mode — displays two images at a time.

Four Image Display mode — displays four images at a time.

Eight Image Display mode — displays eight images at a time.

AHEH BOEE
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The main ISIS Driver

window

The main ISIS Driver window provides a set of several tabs. You can

select each of these tabs and make any choices necessary to meet
your scanning needs.

Properties for KODAK i1440 on None

x|
Diropout I Blank Image Detection I Log I About I
Main I Layout | Image Procezsing | Scanner I Auto Color Detect I Adjugtments
— Image Mode Diats per inch:

Camera: |2EID j

Frort lmage B -

[ Front Image #2 Cropping:

[ Back Image #1 IFixed To Transport j

[ Back Image #2 EBinarization:

| iThreshelding |

Mods: = Ihreshold

Black and ‘white )' ID _IQ

Grayscale i !

Calor i} 255

Auto Detect Grayzcale

Auto Detect Color — Contrast

I =
- o =
50 50

Toaggle Patch

Mone LI

Default I Copy I Ok I Cancel | Help

The buttons on the bottom of the window apply to all the tabs:

Default — when you select Default, the values will be reset to the
factory defaults.

Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up

Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

OK — saves the values set on all tabs.

Cancel — closes the window without saving any changes.

1
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The Main tab provides the following options:

x|
Dropout I Elank Image Detection | Log | About I
I ain | Layout I Image Processing I Scanner | Auto Color Detect I Adjustments
— Image Made Dotz per inch:
Camera: I2DD LI
[ Front Imag #2 Cropping:
[ Back Image #1 IFixed To Transpaort LI
[ Back Imags #2 Birarization:
| Thresholding =l
Mode: = Lhrezhald
Black and Wwhite b ID =
Grayscale i !
Cuolor ] 255
Ao Detect Grayscale
Auto Detect Color
— Contrast
1 =
. e F =
50 a0
Toggle Patch
I Mone ;I
D efault | Copy | Q. I Cancel Help
Image Mode

Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image #2,
Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings
independently. Some settings apply only to black and white images,
others apply to color/grayscale images. By selecting the appropriate
camera and image mode, you can control the scanner’s output.

Mode

» Black and white: if you want your electronic image to represent all
elements of your document in black and white.

» Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

» Color: if you want your electronic image to be in color.

» Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

« Auto Detect Color: sets auto color detect for color. See the section
entitled, “Auto Color Detect tab” for more information.
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Toggle Patch — indicates you want to tell the scanner, via a toggle
patch document, if the document is color/grayscale or black and white.
You can select:

» Off: no patches will be used.

» Same Side: only the side which recognizes the patch sheet will
toggle.

» Both Sides: a patch will be recognized on either the front or the back
side.

NOTE: Not all scanners have toggle patch functionality.

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Select a resolution value from the drop-down list. The default is 200 dpi.
Available resolutions are: 75, 100, 150, 200, 240, 300, 400 and 600 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled “Layout tab” later in this chapter.

» Automatic: dynamically adjusts the cropping window for different
document sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.
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For Kodak i1440 Scanners only:

» Photo: the scanner will locate the photograph on the document and
return an image that contains just the photograph. If the scanner
finds more than one photograph on a document, one image is still
returned. The entire document is used to locate the photograph.

* Photo w/Region of Interest: this option is the same as Photo
(above) except that only a portion of the document (which is specified
on the Scan Area dialog box) will be used to locate the photograph.

» Long Paper: the scanner will split the document into separate
images based on the area you specify on the Scan Area dialog box. It
is suggested that you select an area that covers the entire width of
the document and a height around 11 inches (297 mm).

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

« iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (i.e., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Brightness
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (i.e., text, graphics, lines, etc.) from the
background information (i.e., white or non-white paper background).
When using Adaptive Thresholding, Brightness and Contrast can be
adjusted.

Brightness — changes the amount of white in the color and grayscale
image. Use the slider to select a value from 0 to 255. The default is 90.

Contrast — adjusts the difference between black and white, thereby
making an image sharper or softer.

The difference between black and white is small with a low contrast
setting, so the image is softer. With a high contrast setting, the
difference between black and white is large, so the image is clearer.
Select a contrast value from -50 to 50. The default is 50.
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Layout tab The Layout tab provides the following options:

Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first. When using the Kodak i1400 Series
Scanners, select Top edge first.

Image Orientation

» Automatic: if you select Automatic, the Page Orientation options
are not available.

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the section entitled “The
Scan Area dialog box” later in the chapter for more information.
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Combine front and back images — typically, for a document, one
image is created for the front side and another image is created for the
back side. Turn this option on if you want one image that contains both
the front side and back side of the document. The selections are:

Front Back

Front

Back

Front on Top: front side will be above the Front on Bottom: back side will be above
back side within the image. the front side within the image.

Front Back Back Front

Front on Left: front side will be to the left Front on Right: back side will be to the
of the back side within the image. left the front side within the image.
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Scan Area dialog box The Scan Area dialog box allows you to define the amount of image
data which is returned to your PC.

NOTE: Select the side and image to be defined by highlighting Front
Image #1, Front Image #2, etc. based on the cropping option
(either Fixed to Transport or Relative to Document) selected
for each of these in the Main tab. The scan areas defined for all
camera selections are independent.
]

Camera:
Page Size:
ILettar-ESx'l'lln LI

— Page Layout

" |andscape
= Portrait

Area
¥ Snap

[0
bl
Wwidth: |8 1/2"
Height: 11"

e

LUnits

I Inches LI
Cacel_|

Page Size — the default paper size is set when a scanner is selected.
You can choose a different paper size using the drop-down list.

NOTE: Page Size and Page Layout selections also appear on the
Layout tab. If you make a change on the Scan Area dialog box,
the same selections will be displayed on the Layout tab and vice
versa.

Page Layout
» Portrait: displays the image orientation in the shape of a

conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 1/8-inch increments. This option is not available in
Pixels mode.

» X: the distance from the left end of the scanner to the left-edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

» Width: the width of the scanning area.

» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,

Inches or Centimeters.

e} ]
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Image Processing tab

The Image Processing tab displays the Image Mode and Mode
information that was previously described. Refer to the section entitled,
“Main tab” earlier in this chapter for descriptions.

Drropout I
dain I Layout

— Image Mode
Camera:

[ Front Image #2
[ Back Image #1
[ Back Image #2

Mode:

Properties for KODAK i1440 on None

Elank Image Detection I Log I
Image Processing

Scanner I Auto Color Detect

Document Type:

ITe:-:t with Graphics j

Media Type:

IF'Iain Paper j

Dptionz

|
O Halftone Remcwal
O Irert Image

x|

About
Adjustments

- Add Border
Black and ‘hite | -
Grayscale [ HoleFil
Auto Detect Grayscale Wmize Filker
Auta Detect Colar INone j
JPEG Qluality
IGood j
Toggle Patch Streak Filter
INDnB j I_ On J— IlJ 3:
-2 2
Default I Copy | ,TI Cancel Help

Document Type
» Photographs: the documents are comprised mainly of photos.

» Text: the documents contain mostly text.

» Text with Graphics: the documents contain a mix of text, business
graphics (bar graphs, pie charts, etc.) and line art.

» Text with Photographs: the documents contain a mix of text and
photos.

Media type — select one of the following options based upon the
texture/weight of the paper you are scanning. Available options are:
Plain Paper, Thin Paper, Glossy Paper, Card Stock, Magazine.

Options

» Deskew — automatically straightens a document within £0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi

or a 10-degree skew angle at 300 dpi. This option is not available
when Fixed to Transport or Relative to Document is selected.

NOTES:
- To prevent data loss, the document must have all four corners
within the image path.
- Turning this option on may result in a slower scanning speed.
» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone

screens and effectively eliminates noise caused by the halftone
screen.
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* Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

* Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image.

» Hole Fill —allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g. double-punched or those
having a slight tear that could have occurred when the document as
removed from a binder).

NOTE: Turning this option on may result in a slower scanning speed.

Noise Filter

* (none)

* Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

* Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and visa versa.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

» Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

» Superior: the least amount of compression which produces the
largest image size.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g. dirt, dust, or frayed
edges) or by not following the recommended cleaning procedures for
your scanner.

NOTE: Turning this option on may result in a slower scanning speed.
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Scanner tab The Scanner tab provides the following options.

Properties for KODAK i1440 on None 1[
Dropout I Elank Image Detection | Log I About I
tdain I Layout I Image Proceszing Scanner I Auto Color Detect I Adjuztments
Paper Source: — Multi-Feed Detection
IAD F LI ¥ Length Dretection
— Tranzport Timeout il (Lt
Iﬁ ‘ |1 1.00 in
= seconds
[~ At Set
— Energy Star
¥ Enable v Qltré.so.nic Detection
Sensitivity:
|15 _I; minutes ILDW LI
Action:
IEndJob - Eject paper ;I
Alarm:
IC:'\W’I HNT mediahding. waw (ﬂg
Default I Copy I 0K I Cancel Help

Paper Source

NOTE: Flatbed options are only available if your scanner is equipped
with the Kodak i1400 Series A3 Flatbed Accessory.

» ADF: if you are scanning documents from the input tray.
» Flatbed: if you are scanning documents using the flatbed.

 ADF/Flatbed: when selected, the scanner will detect if the
document(s) to be scanned is in the ADF or on the flatbed.

Transport timeout — allows you to set the amount of time the scanner
will wait after the last document enters the transport before the
transport timeout action is taken. You can specify a time delay setting
from 1 to 300 seconds.

Energy Star — allows you to set the amount of time the scanner will
remain inactive before the scanner goes into an idle state. Choices are:
0 to 60 minutes. The default is 15 minutes.

Special Document Mode — allows you to scan irregularly shaped
documents (e.g., pages with coupons removed or documents with large
holes or cutouts in them) that may produce jams or truncated images.

NOTES:
» This option is not available for all models.

 Using this option may decrease overall throughput
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Multi-feed Detection options

» Length Detection — enable or disable (the default) this option. If
enabled, select the maximum length of the document that can be
scanned without a multi-feed being detected. Length detection is
used when scanning same-sized documents to check for overlap. For
example, if you are scanning 8.5 x 11-inch (A4) documents in portrait
mode, enter a value of 11.25 inches (28.57 cm) in the Maximum
Length field. The maximum value is 13.99 inches (35.56 cm).

» Auto Set: automatically sets the maximum length value to .50-inch
(1.27 cm) greater than the length of the currently selected page size.

Ultrasonic Detection — check this option to set multi-feed detection.

* Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport. Multi-
feeds are triggered by detecting air gaps between documents. This
allows multi-feed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect
labels, poor quality, thick or wrinkled documents as multi-fed
documents.

- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document.
Depending on the label material, most documents with labels
should not be detected as a multi-fed document.

- High: the most aggressive setting. This is a good setting to use if
all documents are similar in thickness to 20-Ib. Bond paper.

» Action — select an option of how you want to the scanner to perform
if it detects a multi-fed document.

- Beep and Continue: if selected, the scanner will beep, display
and log the condition but continue to operate.

- End of Job: if selected, the scanner log the condition and stop
the feeder and transport (the scanner will be disabled).

* Alarm — select this option if you want the scanner to make a sound
when a multi-feed is detected. You can click the Speaker icon to
display the Open dialog box. From the Open dialog box, select the
desired .wav file and click OK.
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Auto Color Detect tab The Auto Color Detect tab provides the following options.

Properties for KODAK i1440 on None 5'
Diropout I Blank Image Detection I Log | About I
I air I Layout I Image Processing I Scanner Auto Color Detect I Adjustments
Color Content — Learn
Use the leam mode to determine the
proper Color Amount for detecting your
— Colar & " color documents. Set the Color
lar &maLn Threshold walue and click the Leam
—_— |— I s | button to begin.
L T R T I T T S B R} 4?_.'I
1 200
rColor Threshold ——————————— Learn... |
. J e I 20_‘I Pages Detected: 0
0 100 Amount Detected: 0
Threshold Detected: O
=
Default | Copy | Ok I Cancel Help

Color Content
« Off: this is the default.

* Low: documents require only a small amount of color to be saved as
color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

* Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.
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» Custom: makes the Color Amount and/or Color Threshold options
available.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom option to manually adjust Color
Amount and/or Color Threshold.

Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — if Low, Medium and High options do not give you the desired
results, use the Learn option.

1. Click Learn and follow the prompts.

2. Place at least 5 representative color documents in the input tray and
click OK. These documents will be analyzed and the recommended
color amount will be calculated for you.

3. Write down the Color Amount and Color Threshold values that
are displayed in the dialog box as these are the settings you will be
required to use in your application.

NOTES:

» These settings were calculated based on the representative color
documents scanned. If these values do not provide the desired
results with your production job set, you may need to manually adjust
the Color Threshold.

* If any of the 5 documents returns a value of 0 for the amount or
threshold, the function will fail and the amount and threshold values
will be inaccurate.

» Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.
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Adjustments tab The Adjustments tab provides the following options.

|
Dropout I Elank Image Detection I Log I About |
Main I Layout I Image Processing I Scanner I Auto Color Detect Adjustments
— Color &djustment r— Image Edge Fil
Bed: P J— IU 3: Fill Calor:
Green: —_— J— ID 3: IWhlte LI
A T = Frame Mods
Blue: _ J— ID 3. r =
oo Leit |1.DUin
-0 50 B
Right: |1 .00 in
Sharpen J— ID 3:
a ! ! 0 Top: |1 00 in
1} 3
Bottarn: |1 00 in
— Background Smaathing
Backaround: IEhange to white LI
Apply ta: IPredominant LI
Aggressiveness: |_ I =1
||||||||||| D _'I
10 10
Default I Copy | Ok I Cancel Help

Color Adjustment

Red — changes the amount of red in the color image.
Green — changes the amount of green in the color image.
Blue — changes the amount of blue in the color image.

» Adjust these settings by dragging the slider bar to the left or right,
entering a value in the text box or using the up/down arrows.

Background Smoothing — using this option for documents or forms

with a background color will help produce images with a more uniform
background color.

» Background: select one of the following:
- None - no background smoothing will be performed.
- Automatic - smooths up to three background colors.

- Change to White - identifies up to three background colors and
substitutes each color with white.
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» Apply to:

- Predominant - smooths the predominant background color to
white.

- Neutral - smooths only the neutral color to white, and also smooths
up to two additional background colors.

- All - smooths the neutral color and up to two additional background
colors to white.

NOTE: The Apply to options are only available for Method: Change
to White.

» Aggressiveness: allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10. The
default is 0.

Image Edge Fill — fills the edges of the final electronic image by
covering the area with the specified color. Image Edge Fill is performed
after all other image processing options have been applied.

Frame Mode — fills in an equal amount of the selected color from the
Image Edge Fill drop-down list on all sides of the image, or you can
select a value in the Top, Left, Right and/or Bottom area(s) from each
side of the scanned image to be filled.

When using this option, be careful not to enter a value too large as it
could fill in image data that you want to keep.
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Dropout tab The Dropout tab displays the Image Mode and Mode information that
was previously described. Refer to the section entitled, “The main ISIS
Driver tab” earlier in this chapter for descriptions.

The Dropout tab is used to eliminate a form's background so that only
the entered data is included in the electronic image (i.e., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

Form Data is Color — allows you to indicate that a color other than
black or dark blue ink, was used for the data entered on the form.
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Blank Page Detection tab Blank Image Detection allows you to configure the scanner to not give
blank images to the scanning application. Select the image size (KB),
below which an image is determined to be blank. Images with sizes less
than the number you select will not be created. If you use this option,
you must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make an
entry in these fields, all images are kept.

Properties for KODAK i1440 on None 5'
tain I Layaut | Image Processing | Secahner I Auta Calor Detect I Adjustrnents I
Diropout Blank. Image Detection | Log | About
lmage Mode——— r— Blank Image Detection
Camera: )
Mode:

O Frant Image #2
[] Back Imags H1 I™ Black and white

[ Back Image #2
.J—. IU KB _I:

Mode: [™ Grapscale
Black and White — |D k& _.:i'
Grayzcale ! !
Cal
Auto Detect Grayscale L ek
Ao Detect Color J— -
; . ID KB _Ij
1 KE 1000 KE
i~ Learm Cartent
Toggle Patch .
Wze the leam made ta determite [mage content Amaurt.
Maone j
Learm | Cantent: 0%
Diefault | Copy Ok I Canicel Help
Mode

* None: all images are given to the scanning application.

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Content amount will be filled in with the amount of content in the
preview image. If you have a representative blank document (e.qg.,
blank sheet with letter head), this can be used to assist with
determining the setting for Content amount (i.e., perform a preview
scan, click this button, and adjust Content amount as appropriate).
This option is only available when there is a preview image.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.

e} ]
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Imprinter tab The Document Printer/Enhanced Printer operates at full scanner
speed. The printer can add a date, time, document sequential counter,
and custom messages.

The print string can be configured to include both literal (static)
information (i.e., information that stays the same for each document,
such as batch name or operator) and dynamic information (i.e.,
information that may change for each page scanned, such as the
document sequential counter). The capture software application
controls static fields; any information that the software allows you to
enter can be sent to the printer.

Properties for KODAK 11400 on STI - 0014 Ed

tain | Lavout | Imags Processing | Scanner | Auto Color Detect | Adjusiments | Dropout  Imprinter I Log | About |

[V On
Format Template: Top Margin:
| @ |t
Date Lnits:
Format: Delirites: Inches 'I
|MmpDivyry x| [Mene x| | Font
Laige Tl
— Counter ~ Botation
Initial ¥ alue: [o = |30 Degress x|

Field Width: 3 3:
Format: H
J Display Leading Zemos R

Example:

Dedault | Copy |

On — check this to enable the document printer/enhanced printer.

Defining your print string Format Template — the format template is used to build the print
string. The print string is what is printed on documents as they travel
through the transport. The print string is printed before the document is
scanned, therefore, it is part of the image. The maximum amount of
characters for each print string is 40 characters (including spaces).

Date — if you want to add a date to the print string, select one of the
following formats:

* Format: MMDDYYYY, DDMMYYYY, or YYYYMMDD.

» Delimiter: select one of the following separators: Slash: /,
Dash: -, Dot: ., Space or none. For example: 08/24/2008,
08-24-2008, 08.24.2008 or 08 24 2008 or 08242008 (none).
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Counter — if you want to add a Counter to the print string, you can
enter one of the following options:

« Initial Value: this value is used to assign the document count for the
next document entering the transport and is incremented sequentially
by the scanner unless another document count is received from the
host. This value is returned in the image header.

* Field Width: used to control the width of the document counter.
Values range from 1 to 9.

* Format — allows you to configure the format of the counter when the
width of the value is less than the field width (the examples indicate a
field width of 3 and the counter at 4). Options are:

- Display Leading Zeros (default): “004”
- Suppress Leading Zeros: “4”
- Compress Leading Zeros: “ 47

Top Margin — allows you to define the distance from the lead edge

before the print string begins. Enter the desired amount in the text box.

NOTE: Printing automatically stops 6.3 mm (1/4-inch) from the trailing
edge of the document even if the information has not been
completely printed.

Units — select Inches, Centimeters or Pixels.

Font — two different character styles, referred to as Normal and
Large, are available.

Rotation — you can select either 0 or 90 degrees.
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Log tab The Log tab provides a listing of any errors that have been
encountered.

Properties for KODAK i1440 on None ﬂ

kM ain I Lapaut I Image Praceszing I Scanner I Auta Color Detect I Adjustrents I
Diropout I Elank Image Detection Log I About

KODAK 11440 on Hone

ADF
+5canner Firmware w.
+5erial Humber <<Simulated::
+Fir=st Read Date Unknown date

Default | Copy | Ok I Cancel I Help I

You can either save this information to a file by clicking the Save icon,
or copy the information to the clipboard which can then be pasted into a

document.
About tab Displays information about your scanner and driver.
5
M ain | Layout | Image Frocessing | Scanner | Auto Color Detect | Adjustments |
Diropout | Blank Image Detection | Log About
A202 Version 2.2.11004.7007
EODaAK 1440

IS S Copyright & 2010 EMC Carparation

QuickDriver Yersion DEBUG 1.0.11007.74001

CERTIFIED

Device Information:

1515 Module KODAE i1440 [ekil 440.P<N] -
Model

ADF

+Scanner Firmware

+5erial Mumber << Simulated: »

+First Read Date Unknown date

+Background Elack

Huost I nterface

Simplex/Duplex Duples

Option

+ rprinter <<Mat installed: >

+Flatbed <<Maot installed: >

+T nnnle Pateh Sunnnrted LI

EMC®, Captiva, and 1515 are registered trademarks, and QuickDiriver iz a trademark of
EMLC Corporation. &l other trademark.s used herein are the property of their respective
OWhers

= Copyright 2010 EMC Corparation. Al rights reserved.

Default Copy Ok I Cancel Help
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